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Fairing a Hull Surface 
The meaning of “fair” is much debated in the marine industry. No one can 
define it, but they know when they see it. Although fairing a surface is 
traditionally associated with hull surfaces, all visible surfaces on a vessel 
can benefit from this process.  

This tutorial will help you understand the general characteristics of fair 
curves and surfaces in Rhino and the steps it takes to create a surface that 
is both fair and accurate. We will start with a set of hull lines and create 
the surface from these. 

Getting Started 
The tutorial starts with a set of lines from an AutoCAD drawing, but lines 
for surfaces can come from many different places including 2-D plan and 
profile drawings, traced scanned sketches, curves created with 3-D 
digitizers, or drawn from scratch in Rhino. Regardless of the origin of the 
curves, the surfacing process is similar. DO NOT assume that curves from 
other people or processes are fair. Always check the curves with the 
techniques covered in this tutorial. 

Characteristics of a Fairness 
As in the real world, fairness on the computer can be quickly assessed 
visually. In addition to standard visual characteristics, Rhino has a few 
tools that assist in analyzing the fairness of a curve and surface. 

In Rhino, the first cue for fairness in a surface is the spacing of the surface 
display isoparms. Comparing the two hull side surfaces illustrated below, 
the first surface has very little chance of being fair. There are many 
unevenly spaced isoparms. They bunch up in areas and spread out in 
others. These are signs that the surface is not fair. You can see that the 
second surface has far fewer isoparms, and they are spaced evenly across 
the surface. Although this in itself does not assure fairness, it is one 
characteristic of a fair surface. The overall shape of these surfaces is very 
close, but for reasons we will be discussing in this tutorial, the second 
surface is much better.  

 

 Surface 1: not fair. 
 

Surface 2: fair. 
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There are other characteristics of fair curves and surfaces. Although a 
curve or surface may be fair without exhibiting all of the characteristics, 
they tend to have these characteristics. If you keep these in mind while 
modeling, you will end up with a better final product. 

The guidelines for creating a fair surface include: 

•  Use the fewest possible control points to get the curve shape.  

•  Use the fewest possible curves to get the surface shape.  

•  Curvature tendencies in one station line are reflected in 
neighboring station lines. 

Use few points 
The first guideline, use the fewest possible control points to get the curve 
shape, sets the stage for all processes that follow. The shapes that we 
create are often subtle. They should not require many points to define 
them. Too many times, when importing lines drawings or curves created 
from digitized points or scanned data, the resulting curves contain an 
immense number of points. In this case having more data is not better. For 
example, these three curves have the same shape.  

 
Simple vs. complex curves. 

The top curve will be fair no matter where the points are located. The 
second curve can be faired with a little work. The bottom curve has too 
many points to make fair or to use for making a fair surface.  

Use few curves 
Like points in curves, using the fewest number of curves will help create a 
fair surface. This does not mean you have to sacrifice the shape of the 
surface; just try to use only the amount of data you really need. Traditional 
lines drawings work well on the lofting floor to describe shapes to the 
shipyard, but for the computer, there are many more curves in a lines 
drawing than you need to describe the surface. Use only the curves that 
describe new features in the surface.  

Station relationships 
The next characteristic has to do with how one station relates to the next. 
Station lines are lines taken off a fair surface. Therefore, their shapes 
should transition in a consistent way from one to the next. This means that 
if a station at the bow has a lot of flare and the stations amidships have no 
flare, each station in between should have progressively less flare. This last 
characteristic of a fair curve or surface seems obvious, but it is often 
overlooked.  



3 

If a curve or surface is not fair, you will have to change the shape to make 
it fair. 

You cannot reduce the number of control points on a surface without 
changing the shape of the surface; but the fewer points the surface has, 
the better possibility you have of creating a fair surface. The trick is to use 
the least number of points required to get the curve or surface you would 
like. More often than not, you will find you can use a small fraction of the 
lines in a lines drawing. You will see in the tutorial that we are able to get 
surfaces very close to the original curves, in fact many times right on, at 
the same time making them very fair. 

Steps to Achieving Fairness 
This tutorial we will be fairing the topside surface on this generic 
powerboat hull. 

 
Powerboat hull. 

A good strategy on a surface that has subtle curvature like this is to use a 
few of the station lines, make them simple curves in Rhino and then loft a 
surface through them.  

In this tutorial, the general steps we will follow are  

•  From the lines drawing, we will copy the station lines we need to 
build the surface, saving the existing lines to check the final 
surface against. 

•  Automatically fair the curves, and then rebuild the curves to 
simple curves. 

•  Manually fair stations and their relationship to other station lines. 

•  Extend and copy lines to complete the lines for a simple surface. 

•  Loft the hull surface. 

•  Edit the surface for fairness and edge shape. 

•  Trim the surface at the edges to get the desired edge. 

Copy the lines needed to create the surface 

 1 Create a new layer called Curves for Surface.  

 2 Use the Dup command to duplicate the station lines of the topside and 
the sheer and chine line.  

 3 Change the layer for these curves to your new Curves for Surface 
layer. 
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Curves from lines drawing. 

 4 Turn off the discarded curves layer. 

 5 There are many more curves here than we need, so delete about half 
the stations.  

  In areas where there is little change in shape from one to the next, you 
can delete more than in areas where there is more change. Here is an 
example of the curves that we have left.  

   
Curves needed to create surface. 

  We were able to delete two out of every three stations at the aft end of 
the surface and every other station toward the bow. Because this will 
be a fair surface, the stations in between will be handled by the surface 
itself. 

Using the Curvature Graph for Fairing 
Now we are ready to start fairing these curves to simple curves. 

The curvature graph will be used many times to look at the fairness of a 
curve or a surface. The command for viewing the curvature graph is 
CurvatureGraphOn (Analyze > Curve > Curvature Graph On).  

 
Curvature graphs. 
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The curvature graph displays the changes in curvature of a curve. If the 
graph changes smoothly, the curve is smooth or fair. Jumps in the 
curvature graph indicate kinks or abrupt changes in the derivatives of the 
curve. In the image above, the blue line is the curve. The white “hairs” 
coming off the blue curve is the curvature graph. This graph magnifies the 
bumps, wiggles, and inflections in the curve. It will also show you which 
way the curve is curving. Along with the display of the curvature graph, the 
Curvature Options dialog box lets you change the size and density of the 
hairs.  

In the image above, the shapes of three curves are very similar. The 
curvature graph tells us that the curves are convex to the right. If the 
curvature graph reversed, the curvature graph would also wiggle to the left 
of each curve. 

The curvature graph for the curve on the left jumps around and has many 
sharp changes in direction. This shows that this curve is not fair. The 
middle curve, which has had some fairing work done on it, has a much 
smoother curvature graph. The graph is smooth except for one area where 
the curvature graph comes to a point and changes direction. For many 
parts of a boat, this can be considered fair. The curve to the right is even 
better. As you can see, the curvature graph is very smooth and much 
simpler than the other two curves, although it deviates in shape very little. 

Fairing to Simple Curves 
Curves have two characteristics in Rhino: the number of control points and 
degree. Degree determines how each control point affects the curve. For 
purposes of fairing, we are interested in simple curves. In mathematical 
terms, simple curves are curves made of a single polynomial span. These 
curves have the special properties because they are the fairest curves 
possible and make very simple surfaces that are easy to edit. To make 
simple curves in Rhino, make curves that have only one more control point 
than the curve's degree. Degree 1 curves (straight line) need only two 
control points; degree 2 curves need only three control points; degree 3 
curves need only four control points, degree 4 curves need only five control 
points, and degree 5 curves need only six control points. If you find you 
need more than six control points, you are probably trying some extreme 
fairing, which makes fairing possible but much harder. Keep this idea of a 
simple curve in mind as we can look at the curves on the hull. 

Analyzing the hull curves 
Select a few stations and turn on the curvature graph. As you can see 
these curves are not fair. They have very dense curvature graphs that 
wiggle back and forth.  

 
Hull curves curvature 
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Now we will a look at the curves individually. 

Problem: s-shape, hook at lower end 

This is a curve aft on the hull. The curvature graph is wiggling back and 
forth. You can see that there is a large spike in the graph at the lower part 
of the curve. This means that it curves much more at the lower end than in 
the middle. You might say it hooks a little at the end. At the top of the 
curve, the graph crosses over the curve. This crossover tells you that the 
curve actually reverses in curvature at the end, making a slight s-shape.  

 
S-shaped hook curve 

Problem: straight at one end, curved at the other 

The next curve in the series, look at the overall curve, ignoring the small 
wiggles. The large spike at the lower part of the curve shows that most of 
the curvature is at the lower end. At the upper part of the curve, the graph 
is very small. In fact, it almost lays right on the curve itself. This means 
that this part of the curve is very close to a straight line. However, since 
the curvature graph lies on the left of the curve, it does not have a reversal 
in it. 

 
Straight at the top, curved at the bottom 



7 

Problem: s-shape, hooked at ends 

Closer to the bow, you will see one curve that looks like this. This curve 
has spikes at both ends; meaning most of the curvature is near the ends. 
It also shows that the curvature reverses about a third of the way up. This 
means that this curve has an s-shape. This reversal in curvature may be a 
start of the flare designed into this type of hull and therefore desired. 

 
S-shape, hooked at ends 

Fairing the curves 
To fair these curves, first determine how many points each curve will 
require. These are some general rules for determining how many points 
you need: 

•  If a curve is supposed to be a straight line, use two control points. 

•  If a curve curves in only one direction, and you only need to 
control where and how much that curve changes, you will need a 
3-degree curve with four-control points. 

•  If a curve is an s-shape reversing curvature in the middle of the 
curve, you need a 5-degree curve with six control points. 

Applying these rules to the lines we have, we can organize the curves this 
way. 

Based on the curvature graphs, curves 1 through 5 curve in two directions 
due to the flare at the bow, so we will rebuild them into 5-degree curves 
with six control points. Curves 6 through 9 curve only one direction, so we 
will rebuild these into 3-degree curves with four control points. 

 
Curvature graphs on all hull curves. 

To rebuild the curves: 

 1 Select curves 1 through 5. 
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 2 Use the Fair command (Curves > Edit Tools > Fair) to automatically 
fair the curves to give you a start in the fairing process. 

 3 Use the Rebuild command (Curve > Edit Tools > Rebuild) to refine the 
curves further.  

  Set the number of points to 6 and the degree to 5. Now the curves are 
simple curves. 

 4 Repeat the process for curves 6 through 9, rebuilding the curves with 4 
control points and degree 3.  

  After this process of auto-fairing and rebuilding you can see that the 
curves are much more fair and the curvature graph is much less dense 
than before; good signs that we are working toward fairness. 

   
Rebuilt curves. 

Refining the curve shapes 
Now we will start moving points on the curves to continue fairing the 
curves and make sure they will create a fair surface.  

We are looking for two things. First, we want to modify the curves so they 
have the shape we want. For instance, we must decide whether we want 
the curvature of the curve to be towards the ends of the curve or toward 
the middle. Second, how does one station line relate to the next? If you 
have a slight convex shape to one station and the next station has a little 
less curvature in it, the third station should have even a little less, so there 
is a smooth transition of curvature from one station to the next. 

For example, the last station at the transom has a light s-shape to it 
according to the curvature graph. We would like it to have a similar 
curvature to the other stations at the end of the boat. It should curve in 
one direction and be convex, with the curvature evenly spaced along the 
curve. To do this we will need to edit the points of the curve. 

 
S-shaped curve curvature. 
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To edit the curve: 

 1 Select the curve and turn on its control points (PtOn or F10). 

 2 Turn on its curvature graph (CurvatureGraphOn). 

   
Editing an s-shaped curve. 

  Normally you should not edit the location of the points at the ends of 
the curve. This will keep the ends on the sheer and chine lines. That 
leaves two other points to edit. Since the curve reversal is close to the 
upper point, we will edit its location.  

  You can drag the points with the mouse to move them, but for the 
small editing of these points, you can use the nudge feature. By using 
nudge, you will get a lot finer control over the position of the points. 

 3 Select the point.  

 4 Hold down the Alt key and press the left arrow key to move the point 
to the left until the curvature graph shows that the curve is convex 
along its length. 

   
Control point moved to remove curve reverse. 

 5 Edit each curve in succession; moving the points to get the shapes as 
shown below. 
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Transitions shown by curvature graphs. 

  Notice how the curvature of each station transitions from one curve to 
another. For instance, curves 9 through 6 are convex, but each one 
curves slightly less than the next as you move forward. At curve 5, we 
start to see the hint of a reverse curve in the upper part. It is very 
slight because it is the first to show a reversal. As you move through 
curves 4 to 1, that reverse curve in the bow grows, as displayed by the 
large curvature graph as the curves move forward. 

Bow Profiles 
The next area that we need to concentrate on is the bow profiles. When we 
use the Loft command to make this surface, if we include the straight bow 
stem as a section, the resulting surface will not be fair. So we will extend 
the bow station beyond the stem line, so the surface will pass through bow 
profile and continue on past centerline. 

To create a bow profile: 

 1 Start by placing a point (Point) at the intersection of the bow station 
and the stem line.  

  This point will serve as a reference when we extend the curve. 

   
Bow reference point. 
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 2 Turn on the control points of the station line (PtOn or F10) and drag 
the station beyond centerline, making sure it stays intersecting the 
point on the stem.  

  You can check this by eye or by turning off the control points and 
turning on the edit points (EditPtOn) and moving the closest edit point 
to the reference point on the stem.  

  Do not add any points to the curve. If you do, the curve will no longer 
be a simple curve. This is easiest to do in the Front viewport. 

   
The red curve is the extended station.  

 3 Copy this curve to the bow of the boat, so there will be two extended 
profiles at the bow. 

   
Copy extended curve to end of surface. 
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Creating the Surface 
Now we can create the surface from the faired curves. 

To create the surface: 

 1 Use the Loft command and select all the profiles in order.  

  When selecting, make sure to select near the top of the profiles, so the 
surface does not twist. Do not select the bow stem line. 

   
Lofted surface. 

  As you can see, the surface has very few isoparm lines in it compared 
to a surface that has not been simplified. Because we used as few 
simple curves as possible, we have a simple surface that can be faired 
easily.  

Assessing the Surface Fairness 
The next step is to see how fair this surface is. The three tools we use to 
do this are surface curvature, surface curve curvature graphs, and looking 
at the order of the control points on the surface. 

To use surface curvature analysis: 

 1 Select the surface and use the CurvatureAnalysis command (Analyze 
> Surface > Curvature Analysis).  

 2 Set the Style to Mean.  

  This displays colors on the surface based on the average curvature at 
each point.  

Using Mean curvature analysis, you can see areas of the hull you may 
want to work on.  
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The color here is not as important as the pattern that the color creates. 
You want the pattern to smoothly transition from one color to another. In 
the illustration below, there are some odd cyan spikes in the lower part of 
the bow area. The slight green and red colors on the sheer line at the bow 
are fine; they transition nicely in and out of the surface. 

 
False color mean curvature analysis. 

To use surface curve curvature: 

 1 Select the surface and use the CurvatureGraphOn command. 

  This is similar to the curvature graph that we used previously for 
curves. On a surface, there are two directions, U and V.  

 2 Turn off the V-direction in the Curvature Options dialog box.  

  The analysis should look something like this: 

   
Surface analysis with curvature graph. 

The curvature graphs here show a fair surface that can be improved 
slightly. At the sheer line near the transom, there is a small reversal in the 
curvature of the surface. In addition, on the sheer line close to the bow 
there is another reversal.  
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To examine the visual order of the control points: 

 1 Select the surface. 

 2 Turn the control points on (PtOn or F10). 

   
Surface analysis with control points. 

Look for area that the control points take unusual turns or where they 
bunch up. You can improve these areas. In this case, the third and fourth 
stations show some uneven spacing.  

Final Fairing of the Surface 
When starting to fair the surface, you have a choice. The Loft command 
creates degree-3 surfaces. This will make the control point of the surface 
very close to the original points on the curves you used. You can leave this 
as it is, or if you are adventurous, you can use the RebuildSrf command 
to rebuild the surface to a degree-5 surface in the longitudinal (U) 
direction. Although the surface will still be on your original curves, the 
control points on the surface will be in a different place than the original 
curves. This may make the surface easier to fair. 

In this case, we chose to rebuild the surface, changing only the degree in 
the U direction to 5. This creates a surface that is slightly fairer as 
demonstrated by the smoother curvature graph curves. 

 
Surface rebuilt in longitudinal direction. 
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To use control points to edit the surface 

 1 Use the MoveUVN command to edit the surface control points. 

   
  The MoveUVN dialog box lets you drag the control points along the U 

and V directions of the surface and the normal direction. Use this to 
move points toward and away from the surface to make the surface 
fair. 

  As you move points around, you can get to a surface that looks like 
this: 

   
Surface edited by moving control points. 

 2 Use the Trim command to trim the bow profile and the transom line 
from the surface to create your finished surface. 

   
Trimmed surface. 
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To find out how much this surface deviates from your original 
curves 

 1 Turn on the layer with the original curves on it.  

 2 Use the Pull command (Curve > from Objects > Pullback) to pull the 
original curves back to the surface.  

 3 Use the CrvDeviation command (Analyze> Curve > Deviation) to 
determine how much the new pulled back curve deviates from the 
original curves.  

  The deviation should be very small: below the tolerance of your 
manufacturing process. 


